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Overview

This guide contains everything you need to know to install, configure, and use Onsite
Inspections.

We urge that Onsite Inspections users read this chapter.

This guide assumes that you know the basics of using the Windows CE operating system
on your Pocket PC. Refer to the Pocket PC online help and documentation for more
information.

Chapter 1
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About This Manual

Important Terms
Throughout this guide, certain terms are used:

• ‘Onsite Inspections’ is a Pocket PC application that lists occupancy and
inspection records exported from FH.

• ‘Pocket PC’ is the mobile computer where Onsite Inspections is installed.
• ‘Dock Computer’ is a computer workstation with FH installed. Any FH

workstation can be used as a dock computer as long as Microsoft
ActiveSync 3.5 or better is installed on the workstation, Onsite Inspections
is activated in FH, and the Onsite Inspections synchronization folder is
accessible to all ‘dock computers’.

See ‘Configure Dock Computer’ on page 19 for information on activating Onsite Inspections in
FH and specifying a synchronization folder.
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System Requirements

Onsite Inspections requires the following:

• Pocket PC with:
• Windows® CE for Pocket PC devices version 3.0 or greater.
• 32 MB available memory.

• Dock computer with:
• Microsoft ActiveSync® 3.5 or greater.

Clients using FH Onsite Inspections and Microsoft ActiveSync
version 3.7.1 have reported problems synchronizing FH Onsite
Inspection records with your desktop. If you have problems
synchronizing FH Onsite Inspection records with your desktop and
are using Microsoft ActiveSync version 3.7.1, we recommend
uninstalling and reinstalling Microsoft ActiveSync version 3.7.

• FH version 5.4 or greater (you must have FH version 5.5.6 or greater to
use FH Onsite Inspections on a Pocket PC 2003 or .CE Net Device), with
Onsite Inspections configured.

See ‘Configure Onsite Inspections on Dock Computer’ on page 19 for more information.
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How FH Onsite Inspections Works

Occupancy records are exported from FH then uploaded from the dock
computer to the Pocket PC, modified on the Pocket PC, then downloaded back
into the dock computer and imported into FH. When occupancy records are
imported back into FH, existing FH occupancy records are overwritten. The
graphic below illustrates the process of completing inspections and updating
occupancy information using Onsite Inspections.

Overview4
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Installation and Setup

If you receive the Onsite Inspections activation and an FH 5 update at the same time, be
sure to apply the update first. The dock computer must have FH 5 version 5.5.6 or greater.
Microsoft ActiveSync version 3.5 or greater must also be installed on the dock computer
and Pocket PC.

Clients using FH Onsite Inspections and Microsoft ActiveSync version 3.7.1 have
reported problems synchronizing FH Onsite Inspection records with your
desktop. If you have problems synchronizing FH Onsite Inspection records with
your desktop and are using Microsoft ActiveSync version 3.7.1, we recommend
uninstalling and reinstalling Microsoft ActiveSync version 3.7.

Disable any synchronization software other than Microsoft ActiveSync whenever the
Pocket PC is connected to the dock computer. Other synchronization software (for
example, HotSync for Palm) could disrupt communication between the Pocket PC and the
dock computer.

Chapter 2
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Installing FH Onsite Inspections

Installing FH Onsite Inspections requires an FH Onsite Inspections activation
diskette and the FH or FH Enterprise installation CD.

Activating FH Onsite Inspections on Dock Computer
FH Onsite Inspections must be activated on the dock computer.

To Activate FH Onsite Inspections
� Insert the FH System Activation diskette that includes the Onsite

Inspections license.

� Access the Administration menu Activate or Update Features option then
select Install System Activation Diskette.

� Press OK. The FH Onsite Inspections module is activated and ready to be
installed.

Onsite Inspections components must still be installed.

Installing FH Onsite Inspections
The Onsite Inspections installation adds components used by the dock
computer and installs Onsite Inspections to a Pocket PC docked to the dock
computer. The steps to install FH Onsite Inspections vary slightly depending
on the operating system.

To Install FH Onsite Inspections
� Determine Windows version of dock computer:

� If the dock computer runs Windows 2000, NT, or XP:
� Log into dock computer as an administrator.
� From the Windows Start menu, select the Settings option Control Panel

option.
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� Double click Add/Remove Programs. The Add/Remove Programs form is
displayed.

� Press Add New Programs then press CD or Floppy.
� Insert the FIREHOUSE Software or FH Enterprise CD.
� Press Next> then Browse to display the Browse dialog. Change the Files

of Type to “Programs”, select AUTORUN.EXE, then press Open.
� Press Finish. The FIREHOUSE Software Installation menu is displayed.

� If the dock computer runs Windows 95, 98, or Me:
� Insert the FIREHOUSE Software or FH Enterprise CD. The FIREHOUSE

Software Installation menu is displayed.

� If autorun is enabled, the installation window is displayed.

� If autorun is disabled, select the Start button, Run option and type
n:\autorun (where n is the CD ROM drive letter) then press OK.
The installation window is displayed.

� Select Pocket PC extension installation (steps vary for FH Enterprise and
standard FH):
� If FH Enterprise, select Install Pocket PC Extensions. The FIREHOUSE

Software Pocket PC Extensions form is displayed.
� For standard FH, select Additional Installation Options, then select

Install Pocket PC Extensions. The FIREHOUSE Software Pocket PC
Extensions form is displayed.

� The default workstation FIREHOUSE Software installation root directory
is displayed.
� Optionally search for additional FH installations by pressing Search

Entire System. Highlight the FH installation you wish to configure for
use with FH Onsite Inspections.

� Press Next>. The selected FH installation path is displayed. Generally the
default location is acceptable. The Occupancy & Inspection Management Pocket
PC extension is already selected.

� Press Next>. The directory for synchronization files is displayed.
Generally the default location for synchronisation files is acceptable.

Records sent between the dock computer and the Pocket PC are
stored in a synchronization folder accessible to FH on the dock
computer. The default location is in the FH root directory in a
folder named PDA. The default location for the FH root directory
is C:\Program Files\FIREHOUSE Software\, yours
may be different. If the Pocket PC will be connected to more than
one dock computer, the synchronization folder should be
accessible to each workstation where the Pocket PC will be
connected (for example, a network folder). All Onsite Inspections
users must have sufficient computer/network rights to access this

7Installing FH Onsite Inspections

Synchronization
Folder



folder. Press Browse to select a PDA folder that is different than
the default location.

� Select the appropriate Pocket PC operating system.

If you are not sure of your Pocket PC operating system, access
your Pocket PC 'Start' menu, select the Settings option, select the
System tab, then the About option. If you have Microsoft(R)
Pocket PC Version 4 or greater, you should select Windows for
Pocket PC 2003 or CE.Net v 2.0.34.

� Press Next>. The Installation Complete form is displayed with Install
Software on Handheld Device selected.

Onsite Inspections is ready to be used at this dock computer. Repeat the steps above for
each dock computer that will export records to Onsite Inspections on a Pocket PC.
Onsite Inspections still must be installed on your Pocket PC. If you are not installing
Onsite Inspections on a Pocket PC, uncheck Install Software on Handheld Device and
press Finish.

� Press Finish>. The License form is displayed:
� Select View SYWARE, Inc. End-User License Agreement then press Next> to

view the license agreement. Close the license agreement when finished.
� Select I Agree, then press Next> to accept the agreement and proceed.

� Connect your Pocket PC to your dock computer. If you need more
information about connecting your Pocket PC to a dock computer, refer to
the documentation included with your Pocket PC.

Microsoft ActiveSync® must be installed and running on the dock
computer and Pocket PC.

� Press Next>. The Installing Applications prompt is displayed. If the
Applications Already Installed prompt is displayed, press Yes to display the
Installing Applications prompt.

� Press Yes. The Installing Applications progress bar is displayed on the dock
computer as Onsite Inspections installation files are transferred to the
Pocket PC, then the Application Downloading Complete prompt is
displayed. Installation on the Pocket PC launches automatically. Note that
you must let the installation to the Pocket PC complete before doing
anything else on the dock computer.

� On the Pocket PC, if the Already Installed prompt is displayed, tap OK. FH
records on the Pocket PC are not overwritten.

Installation and Setup8

Microsoft
ActiveSync®

Pocket PC OS



� If the File in Use prompt is displayed, tap No. If the installation will not
proceed, you may need to close Onsite Inspections on the Pocket PC. See
‘Close Running Programs’ on page for the steps to close running programs
on a Pocket PC.

� If the Confirm File Replace prompt is displayed:
� Select Yes to replace with installation files. Use caution when replacing

existing files since this may cause issues with other programs installed
on the Pocket PC.

� Select No to keep existing files. Installation on the Pocket PC
completes.

� On the dock computer, press OK to the Application Downloading Complete
prompt. The Installation Complete form is displayed.

� Press Finish>.

You must transfer FH occupancy records from the dock computer to the
Pocket PC before using Onsite Inspections.

Instructions for uploading Onsite Inspections to the Pocket PC start on page 16.
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Setting Up FH Onsite Inspections

Before you can start using FH Onsite Inspections, you need to specify the
workstation options that control FH Onsite Inspections behavior, set security.
We also recommend that you set up an inspection checklist to use in FH
Onsite Inspections.

Specifying Workstation Options
You need to specify dock computer workstation options.

To Specify Workstation Options
� Launch FH.

� From the Tools menu, select Workstation Options. The Workstation
Options form is displayed.

� Access the Pocket PC section.

� If you need to change the location created by the installation, press
Directory and select a new location.

The synchronization folder needs to be accessible to all Onsite
Inspections users.

� Check Leave temporary import files from the Pocket PC in the recycle bin after import to
leave files downloaded from the Pocket PC to the Import subdirectory of
the synchronization folder in the Windows Recycle Bin after they are
imported into FH. When not checked, the files are  permanently deleted
after successful import. Note that if the Windows Recycle Bin deletes files
automatically, files are permanently deleted regardless of this option.

� Check Do not check for Pocket PC import files when logging in if you do not want
FH to prompt users to run the Onsite Inspections import when files are
found in the Import subdirectory of the synchronization folder at FH start
up. Only users with security access are prompted to import files.

� Press OK.

Installation and Setup10
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Setting Up User Security
There are Onsite Inspections specific security rights in FH. An FH
administrator needs to ensure that each user has adequate rights to perform
Onsite Inspections tasks in FH.

FH Onsite Inspections on the Pocket PC has no security
provisions. Anyone using the Pocket PC can open Onsite
Inspections and browse downloaded FH information. Refer to
your Pocket PC device’s documentation for information on Pocket
PC security.

To Specify Security
� From the Administration menu, select the Users and Security option. The

Users and Security form is displayed.

� Select the user that needs access, press Properties then click the Modules
tab.

� Set appropriate rights for Onsite Inspections areas:
� Under Occupancy & Inspection Management, locate Synchronize

Inspections on Handheld Device and check Allow to enable the user to export
to the Pocket PC and import from the Pocket PC.

� Under Occupancy & Inspection Management, locate Update Inspection
Checklists and check Allow to enable the user to add new inspection
checklists and edit existing checklists.

� Under Department Journal and Events, locate Transfer files to/from
Pocket PC, and check Allow to enable the user to perform the options
from the Tools menu Pocket PC Tools option.

� Press Save.

Repeat steps above for each user that will be performing Onsite Inspections
tasks in FH.

Setting Up Inspection Checklist
Onsite Inspections includes an inspection checklist that lists items to inspect.
Inspectors tap whether a specific item passes, fails, or is not applicable.
Inspection checklists used in the Pocket PC are set up and modified in FH on
the dock computer. The checklist (or checklists) can not be modified from the
Pocket PC.

We recommend at least one default inspection checklist. Optionally, you can
add additional inspection checklists that are associated with specific
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inspection types. This allows you to tailor the inspection checklist based on
the inspection type. If you do not have a default inspection checklist, only
occupancy information and/or previous violations will be exported if a
reinspection was scheduled for the exported record.

To Add a Default Inspection Checklist
� Access the File menu, Inspection option Inspection Checklists option. The

Inspection Checklists form is displayed. You must have ‘allow’ security
rights for Update Inspection Checklists to edit or add inspection checklists.

� You can edit the default inspection checklist, or add a new checklist.
� To add a new checklist, press New. The Checklist Items form is

displayed.
� To select an existing checklist, highlight the checklist and press

Properties. The Checklist Items form is displayed.

If you already have set up an inspection checklist for Onsite
Inspections, make sure this checklist is marked as the default
checklist or has been assigned a specific inspection type. Verify that
all checklist items are associated with a checklist item category.
Only items associated with a checklist item category are exported
to Onsite Inspections.

If the Properties or New buttons are disabled, you may not have adequate security to
access this area. See ‘To Set Up User Security’ on previous page for details.
� Check Make this the default checklist.
Press F1 at your workstation for more details on setting up the inspection checklist.
� Press OK. The Inspection Checklists form is displayed.

The default checklist is used for records exported to a Pocket PC unless an
additional inspection checklist is associated with a specific inspection type. If
you need to add additional inspection checklists that are associated with
specific inspection types, complete the steps below.

To Associate an Additional Inspection Checklist with Specific Inspection Type(s)
� Access the File menu, Inspection option Inspection Checklists option. The

Inspection Checklists form is displayed. You must have ‘allow’ security
rights for Update Inspection Checklists to edit or add inspection checklists.

� Add new inspection checklist or select an existing inspection checklist:
� To add a new checklist, press New. The Checklist Items form is

displayed.
� To select an existing checklist, highlight the checklist and press

Properties. The Checklist Items form is displayed.
� Press the button next to Link to Inspection Types. The Lookup -

Inspection/Activity Types (MultiSelect) form is displayed.

Installation and Setup12

Use Existing
Checklist



� Select inspection type or types:
� One inspection type: Click on a list item to highlight.
� Inspection types in a range: Click on the first list item in the range,

press Shift, then click the last list item in the range to highlight all
list item between the first and last records in range. Release the Shift
key.

� Inspection type spread throughout the list: Click on a list item, press
Ctrl, then click an additional list item, repeating until all list items are
selected. Release the Ctrl key.

� Press OK and all highlighted inspection types are added. The default
checklist is used if the inspection type is not linked to a specific checklist.

Press F1 at your workstation for more details on setting up the inspection checklist.
� Press OK.

Add as many inspection checklists as needed. Press Close from the Inspection
Checklists form if you are finished adding inspection checklists.

See page 27 for details on completing the inspection checklist on the Pocket PC.
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Move Records to Pocket PC

There are two steps involved in moving records from the dock computer to the Pocket PC:

• Export records, and
• upload records to Pocket PC.

Both steps are usually completed at the same time from the dock computer with the Pocket
PC connected (as detailed in ‘To Select Records for Export and Upload’, below), but there
are situations where the export and upload need to be performed separately. For example,
if occupancy and inspection records are exported from an FH workstation that is not a
dock computer, the records can not be uploaded directly from this computer. Exported
files are placed in the synchronization folder, and can be manually uploaded from any dock
computer to a Pocket PC. See ‘To Select Records for Export Without Uploading to Pocket
PC’ on page 20 for the procedure.

Chapter 3
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Export and Upload Records

Any FH Occupancy record can be exported to your Pocket PC, and you can
select a scheduled inspection for the occupancy if available.

Selecting Records to Export
You can export and upload to your Pocket PC in a single step, or export and
upload separately. Generally you will select records to export to your Pocket
PC and upload the records to the Pocket PC in a single step.

To Select From All Records for Export and Upload
� From the File menu, select Inspections>Export Inspection Records to

Pocket PC. The Pocket PC Data Export form is displayed.

� Press Select Occupancy/Inspection Records to Export. The default
occupancy query of available occupancies is displayed. You can select any
occupancy query.

� Highlight occupancies that you wish to inspect, then press OK.

Move Records to Pocket PC16
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� Select the occupancy and/or scheduled inspection items to include in the
export:
� To exclude an occupancy record and inspection, uncheck the

occupancy record listing.
� To export an inspection record, check the inspection record listing.

Only one inspection record per occupancy can be exported.
� To export an occupancy record and blank inspection record, select the

occupancy record listing (with no inspection items checked or listed for
that occupancy).

� Press Next>. The Pocket PC Data Export form Step 2 section is displayed.

� Select the staff members that perform inspections:

Onsite Inspections includes an Inspector field that lists available
staff. If you have a large number of staff records, we recommend
including only staff members that perform inspections. Including a
large number of staff records can potentially impact Onsite
Inspections performance.

� To limit available inspectors, press Select Staff Members, highlight
staff members to include (multi-select is enabled), press OK then
Next>> and the Step 3 section is displayed.

� To include all staff members as available inspectors, press Next>> and
the Step 3 section is displayed.

� Check Transfer files after export if you are at a dock computer and your Pocket
PC is connected. This will upload the export files to the Pocket PC
(described below).

When transferring files to the Pocket PC, Onsite Inspections
should be closed on the Pocket PC.

� Press Finish. Selected inspections are created in Pocket PC format and
placed in the Export subdirectory of the synchronization folder.

17Selecting Records to Export
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� Press Close.

We recommend that you review available occupancies and inspections on
your Pocket PC before disconnecting your Pocket PC from the dock computer
to verify that desired occupancies are available. If any occupancies were
inadvertently excluded, repeat the export to Pocket PC procedure, selecting
all desired occupancies and inspections. Occupancy and inspection records
exported to the Pocket PC replace existing records on the Pocket PC.

To Export Incomplete Inspections For The Day
� From the File menu, select the Department Journal option.

� Highlight the year, month, and day the inspections are scheduled.

� Press Options, then select Export Incomplete Inspections for (date) to PDA.
The Pocket PC Data Export form is displayed.

� Highlight occupancies that you wish to inspect, then press OK.

� Select the occupancy and/or scheduled inspection items to include in the
export:
� To exclude an occupancy record and inspection, uncheck the

occupancy record listing.
� To export an inspection record, check the inspection record listing.

Only one inspection record per occupancy can be exported.
� To export an occupancy record and blank inspection record, select the

occupancy record listing (with no inspection items checked or listed for
that occupancy).

� Press Next>. The Pocket PC Data Export form Step 2 section is displayed.

� Select the staff members that perform inspections:

Onsite Inspections includes an Inspector field that lists available
staff. If you have a large number of staff records, we recommend
including only staff members that perform inspections. Including a
large number of staff records can potentially impact Onsite
Inspections performance.

� To limit available inspectors, press Select Staff Members, highlight
staff members to include (multi-select is enabled), press OK then
Next>> and the Step 3 section is displayed.

� To include all staff members as available inspectors, press Next>> and
the Step 3 section is displayed.

� Press Finish. Selected inspections are created in Pocket PC format and
placed in the Export subdirectory of the synchronization folder.

� Press Close.

Move Records to Pocket PC18
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To Select Records for Export Without Uploading to Pocket PC
� From the File menu, select Inspections>Export Inspection Records to

Pocket PC. The Pocket PC Data Export form is displayed.

� Press Select Occupancy/Inspection Records to Export. The default
occupancy query of available occupancies is displayed. You can select any
occupancy query.

� Highlight occupancies that you wish to inspect, then press OK.

� Select the occupancy and/or scheduled inspection items to include in the
export:
� To exclude an occupancy record and inspection, uncheck the

occupancy record listing.
� To export an inspection record, check the inspection record listing.

Only one inspection record per occupancy can be exported.
� To export an occupancy record and blank inspection record, select the

occupancy record listing (with no inspection items checked or listed for
that occupancy).

� Press Next>. The Pocket PC Data Export form Step 2 section is displayed.

� Select the staff members that perform inspections:

Onsite Inspections includes an Inspector field that lists available
staff. If you have a large number of staff records, we recommend
including only staff members that perform inspections. Including a
large number of staff records can potentially impact Onsite
Inspections performance.

� To limit available inspectors, press Select Staff Members, highlight
staff members to include (multi-select is enabled), press OK then
Next>> and the Step 3 section is displayed.

� To include all staff members as available inspectors, press Next>> and
the Step 3 section is displayed.

� Leave Transfer files after export unchecked.

� Press Finish. Selected inspections are created in Pocket PC format and
placed in the Export subdirectory of the synchronization folder.

� Press Close.

You still need to upload the exported records to the Pocket PC.
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Manually Uploading Exported Records
If you selected records to export to Onsite Inspections but you did not upload
the files to a Pocket PC, these files are in the Export subdirectory and can be
manually uploaded at any time. For example, if one person selects records to
be inspected from their workstation, and a different person performs the
inspection, the person performing the inspection can upload the selected
records from their workstation.

To Manually Upload Exported Records
� Connect the Pocket PC to the dock computer. Verify that Onsite

Inspections on the Pocket PC is closed.

� From FH on the dock computer, select Tools menu, Pocket PC Tools option
Upload Files to Pocket PC option.

� If prompted “This database already exists. Do you want to replace this
database?” press Yes.

Records in the Export subfolder of the synchronization folder are uploaded
to the Pocket PC. The upload process may take several minutes depending on
the connection speed between the dock computer and Pocket PC, number of
selected records, and speed of the Pocket PC.
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Use Onsite Inspections on the Pocket PC

Onsite Inspections is an FH application that runs on your Pocket PC and allows inspectors
to complete occupancy inspections and update occupancy information on a Pocket PC.
After you have exported inspections from the dock computer and uploaded them to the
Pocket PC, you are ready to start using Onsite Inspections.

Instructions for exporting inspections to the Pocket PC start on page 16.

Chapter 4
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Configuring Onsite Inspections

There are several configuration options that control Onsite Inspections
behavior.

About Configuration Options
Available configuration options will vary depending on your Pocket PC’s
operating system.

To Set Configuration Options (Windows for Pocket PC 2000 or 2002)
� Tap the Pocket PC Windows Start menu, then FIREHOUSE Software.

� Tap Inspections, select an inspection then tap OK. Select an inspection
type if prompted.

� Tap the Tools menu Configuration option. The Configuration Options form
is displayed.

� Specify configuration options:
� Check Automatically Save on Exit to save each form section automatically

when you exit the form section. If this is not checked, you are
prompted to save changes as soon as you leave a form section.

� Check Use Hardware Keyboard to enter data into Onsite Inspections using a
hardware keyboard connected to your Pocket PC. If this is checked, the
on-screen keyboard will not automatically pop up when data entry
fields are tapped.

� Check Prompt User to Recheck Previous Violations to display previous
violations (if they exist) after the Inspection form Basic Inspection
Information section. Previous violations are available from the Inspection
form Inspection Checklist section Prev Violations button (only available
when previous violations exist).

� Check Display Occupancy Address Before Name in Inspection Browser if
inspections will be selected by address instead of the occupancy name
(occupancy name is still listed but you will have to scroll to the right to
see it).

� Check Default Recheck Date With Most Recently Entered Recheck Date to insert
the most recently used Recheck Date for a failed inspection item when
Violation Noted is selected for a previous violation.

� Check Default Repaired Date to System Date if Selected to insert the system
date when Repaired is checked for a previous violation.
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� Check Default Inspector to insert the specified Inspector if the Inspector
value is empty in the inspection record.

� Tap OK to save options, or Cancel to exit without saving changes.

� Tap the Form menu Exit option.

You are ready to complete inspections and update occupancy information on
your Pocket PC.

To Set Configuration Options (Windows for Pocket PC 2003 or CE.Net)
� Tap the Pocket PC Windows Start menu, then FIREHOUSE Software.

� Tap Inspections, select an inspection then tap OK. Select an Inspection Type if
prompted.

� Tap the Tools menu Configuration option. The Configuration Options form
is displayed.

� Specify configuration options:
� Select Prompt User to Recheck Previous Violations automatically to display

previous violations (if they exist) after the Inspection form Basic
Inspection Information section. Previous violations are available from the
Inspection form Inspection Checklist section Prev Violations button (only
available when previous violations exist).

� Check Display Occupancy Address Before Name in Inspection Browser if
inspections will be selected by address instead of the occupancy name
(occupancy name is still listed but you will have to scroll to the right to
see it). Records are sorted by the initial column.

� Check Default Recheck Date With Most Recently Entered Recheck Date to
automatically insert the most recently used Recheck Date for a failed
inspection item when Violation Noted is selected for a previous violation.

� Select Default Repaired Date to System Date if Selected to automatically insert
the system date when Repaired is checked for a previous violation.

� Press Next Pg>>.
� Check Automatically Save on Exit to save each form section automatically

when you exit the form section. If this is not checked, you are
prompted to save changes as soon as you leave a form section.

� Check Use Hardware Keyboard to enter data into Onsite Inspections using a
hardware keyboard connected to your Pocket PC. If this is checked, the
on-screen keyboard will not automatically pop up when data entry
fields are tapped.
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� Check Preprocess All Responses For Checklists With Less than and specify the
number of items to select the default maximum number of records to
pre-process for the checklist. If the checklist includes fewer items than
the selected number, all checklist responses are pre-created when the
inspection is selected. If the number of checklist items is greater than
the specified maximum, only one page of inspection items is created.
Additional checklist item pages are processed when you display the
page. For inspections that include inspection checklists with many
items, specifying a preprocess maximum minimizes the time to display
the inspection.

� Select Default Inspector automatically inserts the specified Inspector if the
Inspector value is empty in the inspection record.

� Tap OK to save options, or Cancel to exit without saving changes.

� Tap the Form menu Exit option.

You are ready to complete inspections and update occupancy information on
your Pocket PC.
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Using Onsite Inspections

Once you have installed FH Onsite Inspections and uploaded some records
from the dock computer to the Pocket PC, you are ready to access records on
your Pocket PC.

To Complete A Basic Inspection
� Tap the Pocket PC Windows Start menu, then FIREHOUSE Software.

� Tap Inspections.

� Tap a listed record then tap OK.
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The FIREHOUSE Software Onsite Inspections splash
screen is displayed.

The Occupancy Inspections query lists available
inspections sorted by occupancy name.

Accessed directly from the Records menu Browse
option.

Windows for Pocket PC 2000 shown, yours may vary.



Press Search and type an occupancy name, or part of an
occupancy name, to locate an occupancy inspection in a long list.

If no Inspection Type is included in the opened inspection, you are prompted to assign an
Inspection Type.

If an inspection type is included, the Inspection form Basic Inspection Information form
is displayed.

� Tap the Complete check box to add a checkmark (indicating that the
inspection is complete) and select the Complete date.

� Complete remaining basic inspection information as needed. Each field
displays a list of valid
values when you tap :
� Lookup fields display

valid lookup code
values. Select Group: (if
applicable) and then
code value, then press
OK.

� Date fields display a
calendar dialog. Select
desired date then
press Ok.

� Time fields display a
time dialog. Enter the
hour and minute, then press OK.

You can navigate through the form sections using the
buttons at the bottom of the form. If the
buttons are used before the form fully displays, you

might skip a section. All Onsite Inspections record form sections
are also accessible directly from the Form menu.
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The selected Inspection Type is

added to the inspection record

and can not be edited on the

Pocket PC, so choose carefully.

� Select a code (if the codes are grouped, you
first select a group). The inspection is
displayed.

Accessed directly from
the Form menu
Inspection Basic
option.

Choose
Carefully

Search

Form Navigation



� Tap to complete the inspection checklist. If there are no previous
violations, the inspection checklist is displayed. An inspection checklist
can span multiple sections. See ‘Complete Inspection Checklist’ on page 28
for steps.

When previous violations are included in the inspection record exported from
the FH dock workstation, they are automatically listed before the Inspection
form Inspection Checklists section is displayed the first time the inspection
record is opened. This allows an inspector to review previous violations only,
without going through the inspection checklist. Previous violations may
include inspection items that are not included in the inspection checklist.

� Highlight a previous violation and press Edit.

Violation notes are displayed. Review violation details, then select the
appropriate option:
� Check Violation Noted - Reported if the violation still exists, but no

reinspection is necessary.
� Check Violation Noted - Recheck Dt and specify a date to reinspect. The

date can automatically be inserted. See ‘Set Onsite Inspections
Configuration Options’ on page 19 for details on enabling.

� Check Repaired and specify the date the violation was repaired (or noted
as repaired). The date can automatically be inserted. See ‘Set Onsite
Inspections Configuration Options’ on page 19 for details on enabling.

� Press Ok. Review additional previous violations as necessary.

� Press Close when finished reviewing previous violations.

The Inspection form Inspection Checklist section is displayed. Complete
remaining sections as necessary. Typically, when the inspection is for
reviewing previous violations only, you are finished with the inspection. See
‘Save Inspection Record’ on page 29 if you are finished with the inspection.
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using the Prev Violations button at the bottom of
the Inspection form Inspection Checklists section
The Prev Violation button is not available if no
previous violations exist for the inspection record.



Complete Inspection Checklist

The inspection checklist is also available from the Inspection form Violations section in FH at
the dock computer. See the FH Online Guide ‘FIREHOUSE Software Inspection Checklist’
topic for additional information.
� Each field displays a list of valid values when tapped:

� Tap to enter the inspection item status. Values are Pass, Fail, or N/A.
� If the inspection item is Fail, enter notes for the item. Type a Count value

if there are multiple violations of this type. If you add a Scheduled
Recheck date, you are prompted to create a scheduled inspection when
the completed inspection record is imported into FH. You can also note
a Repaired date if relevant.

See 'Import Completed Inspections', page 32 for information on importing completed
inspection records from the Pocket PC.
� Complete necessary inspection items. There may be multiple pages of

inspection items depending on the inspection checklist.

� Tap to complete responsible name and address information.
� Each field is

text-entry. Tap
and use
standard text
entry methods
to enter field
value.

� Tap to
complete
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The Inspection form
Responsible Name/Addr section
displays inspection responsible
party name and basic address.
Press Select From Occupancy
Contacts to complete this
section using information from
an occupancy contact record.
Accessed directly from the
Form menu Responsible
Party option Name/Address
option.

The Inspection form Inspection Checklist section lists
inspection items you set up in FH via the File menu
Inspections option Inspection Checklist option, or via
the Administrative Options form Occupancy section
form. See page 11 for details on setting inspection
checklists up.

The Prev Violations button is only included in the
lower right corner if previous violations for the
inspection exist.

Accessed directly from the Form menu Checklist
option.



responsible name phones and emails.

� Each field displays a list of valid values when tapped:
� Phone fields display a contact phone dialog. Enter a Phone Type, Phone,

and Extension (if applicable), then press OK.
� Email fields display a text entry field. Enter email address information

then press OK.
� Tap to complete inspection notes.

Save Inspection Record
� Select Record menu, Save option to save changes.

� Browse for additional occupancies from the Record menu, Browse option.

About Signatures
Signatures can only be added to completed inspections. Typically, the
signature will be from the responsible party. Signature functionality is
specified from the dock computer via the Administrative Options form
Database section Rules and Security section. When the inspection is imported back
into the FH dock computer, the signature is attached to the inspection record.

To Add A Signature
� Tap the Pocket PC Windows Start menu, then FIREHOUSE Software.

� Tap Inspections.

� Tap a listed occupancy inspection then tap OK.

� Tap the Form menu, Signature option.
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displays inspection responsible party phone and email
information.

Accessed directly from the Form menu Responsible
Party option Phone/Email option.



� Enter a signature.

� Tap OK to add signature to record.

Updating Occupancy Information
You can access and edit basic occupancy contact information.

To Update Occupancy Information
� Tap the Pocket PC Windows Start menu, then FIREHOUSE Software.

� Tap Inspections.

� Tap a listed occupancy inspection then tap OK. Select an inspection type if
prompted.

� Tap the Form menu. Available Form menu options for specific occupancy
forms are listed below.
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For basic address
information select the
Occupancy Basic option,
Address option.

For contact information
select the Occupancy
Basic option, Phone/Email
option.

For property usage
information select the
Building Info option,
Property Use option.



� Browse a different occupancy record by selecting the Record menu,
Browse option. Tap the occupancy form name then press OK to display.

You can navigate through the form sections using the buttons at
the bottom of the form, or access a section directly via the Form menu.

Printing Reports
Onsite Inspections includes basic reports that can be printed from the Pocket
PC if printing is configured for the device. You must have a Pocket PC
compatible printer configured for the device to print Onsite Inspections
reports. Only completed inspection records can be printed.

To Print Report
� Tap the Pocket PC Windows Start menu, then FIREHOUSE Software.

� Tap Inspections.

� Tap a listed occupancy inspection then tap OK.

� Tap the Record menu Print option. All available standard and custom
reports are listed.

� Select report to run.
We provide basic reports. Details on creating your own custom reports are listed in Appendix
A on page 3.
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For property usage
information select
Building Info,
Grade/Detectors/
Extinguishers option.

For occupancy contacts
information select the
Occupancy Contacts
option.

For occupancy notes
select the Occupancy
Notes option.



� The selected report is displayed in the Print Preview window.

� Press Print. Assuming that you have a working serial or infrared
connection between your computer and a printer:
� The Windows Print dialog box appears.
� Set the options as desired and click OK.

� Press Close. You can select another report, or press Exit.

The report is sent to the printer.
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Move Records to Dock Computer

There are two steps involved in moving records from the Pocket PC to the dock computer:

• Download records from the Pocket PC to the dock computer, and
• import records.

Both steps are usually completed at the same time from the dock computer  with the
Pocket PC connected (as detailed in ‘Import Completed Inspections from Pocket PC’,
below), but there are situations where the download and import need to be performed
separately. For example, if occupancy and inspection records are downloaded from the
Pocket PC by one person and the import is performed by a different person, the steps may
need to be performed separately. Downloaded files are placed in the Import subfolder of
the synchronization folder, and can be imported from any dock computer. The procedure
for downloading records from the Pocket PC are listed in ‘Download Records from Pocket
PC’, on page 36.
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Importing Completed Inspections

Completed inspections and updated occupancy information in Onsite
Inspections should be downloaded to the dock computer and imported as soon
as possible. If updated Onsite Inspections records are not downloaded in a
timely manner, and occupancy records are updated in FH, these modifications
could be overwritten when the Onsite Inspections records are imported from
the Pocket PC.

Onsite Inspections should not be transferred from the Pocket PC
to the dock computer more than one time.

If you export an occupancy to the Pocket PC, update the occupancy then
import it back to FH on the dock computer, and need to return to that same
occupancy for another inspection, you should export the occupancy from the
dock computer to the Pocket PC rather than use the occupancy record
currently on the Pocket PC. You can opt to clear FH Onsite Inspections
records.

Downloading and Importing Completed Inspections
You can download and import completed inspections as soon as the
inspection records are saved.

To Download and Import Completed Inspections
� Connect the Pocket PC to the dock computer. Verify that Onsite

Inspections on the Pocket PC is closed.

� From the File menu, select Inspections>Import Inspection Records from
Pocket PC.
� If complete inspections have been downloaded from the Pocket PC, the

Pocket PC Data Export form is displayed.
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� If completed inspections have not been downloaded from the Pocket
PC, you are prompted to transfer them. Select Yes to prompt and files
are transferred. Press OK when prompted and the Pocket PC Data
Import form is displayed.

� Review what is included in the import if desired. Select item and press
. Information included varies depending on what information is

included in the record:
� If the main occupancy item was selected, the Record View form

includes the occupancy record, an occupancy contact, occupancy phone
number(s), and occupancy email(s).

� If the scheduled inspection was selected, the Record View form
includes the inspection record, and if included, violation record(s)
reported, inspection phone number(s), and email address(es).

� When a record has been updated, the record’s title indicates that the
record has been updated.

� When a detail record has been deleted, the record’s title indicates that
the record has been deleted.

� Press OK to close the Record View form.
� Uncheck items you wish to exclude from the import:

� Uncheck an occupancy if you do not want to import updated occupancy
information and the inspection record.

� Uncheck an occupancy inspection if you do not want to import the
inspection record but still want to import the occupancy information.

� Press Next>>. Check Clear Pocket PC files after import to erase all records on
the docked Pocket PC.

� Press Finish. All modified occupancies and inspections are imported into
FH. System rules and validation is active and the Validation Result form is
displayed. When completed inspection record from the Pocket PC include
failed inspection items with a date, you are prompted to create a
scheduled inspection for each unique date specified.

Files in the Import subdirectory of the synchronization folder are
permanently deleted after inspection records are successfully
imported into FH from the Pocket PC unless otherwise specified
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Workstation
Options

All occupancies and
inspections from Onsite
Inspections are displayed.
Checked items will be
imported, overwriting
existing records.



in the Workstation Options form. See 'Specify Workstation
Options' on page 10 for details.

To Download Records to Dock Computer Without Importing into FH
� Connect the Pocket PC to the dock computer. Verify that Onsite

Inspections on the Pocket PC is closed.

� From the Tools menu, select the Pocket PC Tools option Download Files
from Pocket PC option. Records from the Pocket PC are downloaded to the
Import subfolder of the synchronization folder.

The download process may take several minutes depending on the connection
speed between the dock computer and Pocket PC, number of records, and
speed of the Pocket PC.

FH checks for files in the Import subfolder of the synchronization folder at
login and prompts you to import the files.

Reviewing Import/Export Activity
You can view a log of Onsite Inspections export and import activity.

To Review Import/Export Activity
� From the Tools menu, select the Pocket PC Tools option View Pocket PC

Import/Export Log option. The Pocket PC Import/Export Log form is
displayed.

� Check Show entries performed at this workstation only to display Onsite
Inspections activity performed at this workstation only.

� Highlight an entry and press Detail to view details about the export or
import.

� Highlight an entry and press Delete to remove the entry.

� Press Purge to remove all entries.

� Press Close to exit.

Move Records to Dock Computer36



Troubleshooting

This chapter lists potential issues you may encounter using Onsite Inspections.
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Problems On The Pocket PC

Below are some potential issues you may encounter from

File In Use
When you are prompted that files are in use on the Pocket PC, tap No to
proceed. If the operation will not proceed, you need to close Onsite
Inspections on the Pocket PC. To check to see if Onsite Inspections is running,
do the following on the Pocket PC:

� Tap the Windows Start menu.

� Tap Settings.

� Tap the System tab.

� Tap Memory.

� Tap the Running Programs tab.

� If FIREHOUSE Software is included in the Running Program List:,
highlight it.

� Press Stop.

Files Not Synchronizing
Clients using FH Onsite Inspections and Microsoft ActiveSync version 3.7.1
have reported problems synchronizing FH Onsite Inspection records with
your desktop. If your FH Onsite Inspections records are not being updated
with records from the dock computer, you may be having problems
synchronizing. If you have problems synchronizing FH Onsite Inspection
records with your desktop and are using Microsoft ActiveSync version 3.7.1,
we recommend uninstalling and reinstalling Microsoft ActiveSync version
3.7.
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Custom Reports

Onsite Inspections includes default reports that can be printed from your Pocket PC. You
can create additional reports for Onsite Inspections using Report CE® 4.0. Creating custom
reports requires third-party software from Syware, Inc. More information on this product
is available at http://www.syware.com.

Custom reports will be enabled and listed if they exist in the reports folder. For a custom
report to be listed, the report name must start with CUST_. The CUST_ will be removed
from the name in the custom reports list, and any underscores will be shown as spaces.

Reports are developed in Reports CE® 4.0. A table with the most common data elements
has been created to simplify report creation. This table is called FH.CDB. Other tables in
the data directory can be used if desired.
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